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Overview 
This document was designed to be used in conjunction with the workshops taught by Web Services through TMCC's 
Professional Development office. We highly recommend attending the workshops. The information in this document is 
not a substitute for the information provided in the workshops. 

This document reviews the features of the official TMCC template designed for documents to be posted to TMCC's website. 
The template is in compliance with TMCC logo usage, EEO/AA statements, and Web editorial guidelines and policies.  

If you are creating internal documents for your department that will not be posted online to the TMCC website you are not 
required to use the TMCC templates and styles. 

Templates provide a user-friendly solution and stable foundation for quickly placing TMCC content online in a consistent 
and recognizable style. The template has been developed by Web services, in conjunction with Marketing and 
Communications, for use by TMCC departments, offices and/or student clubs/organizations. Each template is also pre-
loaded with TMCC styles for consistency across departments. 

Documents posted to the TMCC website can be viewed by anyone in the world, and can be "cached" for viewing even after 
they have been removed from the TMCC website, in some cases. It is important to always include identifying information in 
online documents so that they are easily recognizable as having originated with Truckee Meadows Community College. It is 
equally important to have creation/revision date information. 

You will find Helpful Hints throughout this document to assist you. 

If you have any questions about using the templates and/or built-in styles, contact TMCC's Web Services Department. 

About  the Template 's  Page Layout  

The TMCC template includes standardized features such as page margins, headers and footers. These styles will 
automatically carry over from the first page to multiple pages. The footer will automatically adjust the page numbering. 
The revision date in the footer is set by default. 

About  TMCC Sty les 

The template includes a full set of TMCC-formatted font and text styles. These styles replace Microsoft Word's default 
styles. 

By default, text in the template is formatted in 'Normal (TMCC style)'. There are also several different standardized 
header/sub-header styles from which to choose, bulleted list styles, and numbered list styles. 

To preview styles: select text anywhere in the template document and its style will appear highlighted in the Styles area 
of the Home tab in the Word ribbon. Hover over different styles to see your text previewed in that style prior to selecting 
it. (Note: "Heading Style 4" which has an underline as part of its built-in style, requires that you have a hard return at the 
end of the text for the underline to show up in the document/form.) When a style has been applied to text, that style will 
have a gold box highlighted around it in the Styles ribbon. 

http://www.tmcc.edu/prodev/
http://www.tmcc.edu/prodev/
http://www.tmcc.edu/web/contact/


Using TMCC Styles and Templates 

Page 3 of 12; Using TMCC Styles and Templates  Created: 1/29/2015; Rev: 3/21/2019 

TMCC is an EEO/AA institution. See http://eeo.tmcc.edu for more information. 

Using the Template and Styles 
Gett ing Star ted 

Helpful Hint: Turn on the "show paragraph marker" tool  found in the Paragraph section of your Home ribbon, to see 
your paragraphs, tabs and line breaks, etc. while you are formatting your document. You can toggle this feature on and 
off. 

 

Step 1: Open a new document by double-clicking on the template (the template is a .dotx document). A new blank 
document (.docx) will open.  

Update the document's header and footer: 

• To access the header area, double click anywhere in the grayed-out header or footer sections. 

 

Helpful Hint: Be sure to use the same department name on your document as what appears on your other online 
documents; this should be the same as appears on your department's Web pages. 
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• Give this document your Department Affiliation and Title by typing your department name over the generic text in 
the header (underneath the TMCC logo). 

 

• Be sure that your header/title does not wrap; be concise. If your header/title information is too long for the space 
in the header/title area (the shaded space at the top of page 1 with the line above and below the words), put any 
"overflow" information underneath using the H2 sub-header style. (For example: "How to Create Documents and 
Forms for the Web Using TMCC Styles and Templates" will not fit in that header/title space; you could, therefore 
use "Using TMCC Styles and Templates" as your header/title and then add, just underneath: "How to Create 
Documents and Forms for the Web" as your sub-header. 

• Follow the same procedure for the ‘Document Title’ text located in the footer of the document. For multiple pages, 
updating the footer in the second page will automatically update subsequent pages. 

 

Step 2: Give the document accurate metadata using the Document Properties Panel: 

• Click the 'File' tab 
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• Click the 'Info' section of the menu on the left (if it’s not already selected) 

 

• From the right side of the screen, under the thumbnail of your document, click ‘Properties’ 

 

• Click 'Show Document Panel' 
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• In the Document Properties window: type your department name in the 'Author' field, prefaced by "TMCC", and the 
new Document Title into the 'Title' field. 

 

Step 3: Save and name your document. Use a naming convention that incorporates your department's name followed by a 
short title (about 20 characters), using hyphens and no capital letters, no spaces or underscores, i.e., "web-tutorial-
example.doc". View your department's documents and forms on the website to view current titles. 

Step 4: Type in your document's content. Once you are satisfied with your content and, if the document is to be published 
to the Web, follow the standard Web publishing procedures to convert your file into a PDF (using Adobe Acrobat Pro) and 
optimize it. Alternatively, save your Word document and send to Web Services for further processing. 

Helpful Hint: A neat, organized document that is well laid out will ensure important items are noticed by the end user 
without the need for emphatic devices such as underlining, all-capitals, and so on which tend to be overused and 
ineffective. 

Apply ing the TMCC Sty les 
You can choose to start typing directly into the blank template, or copy and paste text from another document into the 
template.  
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When copying/pasting text from another document, right-click and choose the paste option "Keep Text Only" (clipboard 
icon with the capital letter 'A') which will preserve the template's Normal formatting, rather than importing any formatting 
that was in the source document. 

 

Format your text by applying TMCC styles from the Styles palette on the ribbon. Note that some non-TMCC styles 
(Microsoft Word styles) may also appear in the palette. 

 

Select the text for the headers and sub-headers, and apply your desired TMCC header styles. 

 
 

Select the text for the body of the document and apply the "Normal" style. 

 
  



Using TMCC Styles and Templates 

Page 8 of 12; Using TMCC Styles and Templates  Created: 1/29/2015; Rev: 3/21/2019 

TMCC is an EEO/AA institution. See http://eeo.tmcc.edu for more information. 

If needed, apply numbered and/or bulleted styles; use the increase/decrease indent tool for different levels. 

 

Note that, after pasting in text from another document, you may need to highlight the new text and hit the 'Normal' style 
button to apply the style to the new text. 

Helpful Hint: Insert page breaks rather than using the enter/return key repeatedly to move to the next page. 

Style Modifications: 'Normal' styled text can be adjusted to be bold or italicized in the usual way, using the buttons 
found on the 'Font' section of the ribbon under the 'Home' tab. Apply adjustments to only select text, without affecting the 
styles of the other surrounding text and without "un-styling" it entirely. Note that if you go back later and select your 
modified text and hit the 'Normal' style button, your modifications will be lost and the text will revert to the Normal style. 

Helpful Hint: Add only one single space after the end of a sentence not two spaces. 

Hyper l inks 

TMCC hyperlinks are styled with no underline, using TMCC green (color profile = RGB 128, 128, 0) as the font color. To 
insert a styled hyperlink: 

 After typing in your text, select the text and right-click 

 Select "Hyperlink" 
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 Add the web address (and be sure that the "Text to Display" in the top bar of the window is accurate) 

    
 Microsoft Word automatically applies a default hyperlink style (it may look like this). To override this style and 

replace it with the TMCC Hyperlink Style, highlight your new link and click on the 'Hyperlink' style in the Styles 
section. 

 
 Your link should now look like this: http://www.tmcc.edu 

Note: We do not link TMCC Google docs or other PDFs inside a PDF on the website. If the text indicates a link to one of 
those, you can either list it as just the URL or list the name/title of the Google doc/PDF and list the URL in parentheses 
after the name/title. This way the reader can still easily access the info by copying/pasting the URL into a browser. Do not 
include "http://www." in the URL name.  

Using Numbered/Bul le ted L ist  Sty les 

Helpful Hint: The increase/decrease indent tool (located in the Paragraph area of the ribbon)          is best 
practice within the TMCC templates for adjusting line and paragraph spacing, rather than tabbing or spacing using the 
space bar. It is also the best practice for creating nested lists within bulleted/numbered lists. 

 

To create numbered/bulleted lists: type your list items, then click on either the Bulleted List style or the Numbered List 
style in the 'Styles' section of the ribbon under the 'Home' tab.  

http://www.tmcc.edu/
http://www.tmcc.edu/
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There are two styles of Bulleted and Numbered lists available: one that has more space between the bullets/numbered 
items, and one that has tighter space between the bullets/numbered items. The lists follow very similar style to the default 
Microsoft Word bullet/number styles, but format the text into the approved TMCC font type and size. 

Helpful Hint: Because numbered and bulleted styles are designed so that hitting "Return" automatically formats the next 
line of text as a numbered/bulleted item, when your list is complete you will need to style the text after the last 
bullet/numbered item as either "Spacing" to add a small space before your next line of text, or as "Normal" if you want to 
start your next line of text immediately after the last bullet/numbered item. 

Examples of Bulleted List Styles 

Here is an example of 'Bulleted List 1 (TMCC style)'—this style has 3pt spacing above and below each bullet and is used 
generally for short sentences or succinct items. Use this style generally for words or short sentences. 

• Bullet 1 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam id quam nec mauris ornare molestie ac et 
metus. Morbi faucibus lacinia quam, vitae euismod tellus 

• Bullet 2 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam id quam nec mauris ornare molestie ac et 
metus. Morbi faucibus lacinia quam, vitae euismod tellus 

• Bullet 3 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam id quam nec mauris ornare molestie ac et 
metus. Morbi faucibus lacinia quam, vitae euismod tellus 

Here is an example of 'Bulleted List 2 (TMCC style)'—this style has 12pt. spacing above and below each bullet and is used 
generally for longer sentences and paragraphs. Use this style generally for longer sentences or paragraphs. 

• Bullet 1 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam id quam nec mauris ornare molestie ac et 
metus. Morbi faucibus lacinia quam, vitae euismod tellus.  

• Bullet 2 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam id quam nec mauris ornare molestie ac et 
metus. Morbi faucibus lacinia quam, vitae euismod tellus. 

• Bullet 3 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam id quam nec mauris ornare molestie ac et 
metus. Morbi faucibus lacinia quam, vitae euismod tellus. 

Examples of Numbered List Styles 

Here is an example of 'Numbered List 1 (TMCC style)'—this style has 3pt spacing above and below each numbered item. 
Note that the numbered lists are aligned left, rather than right (noticeable after reaching double and triple digits). 

Helpful Hint: if you have several numbered lists, separated by un-numbered text, you may need to right-click on the lists 
and choose "Restart at 1" unless you want all of the lists to be numbered consecutively. 

 List item 1 
 List item 2 
 List item 3 
 List item 4 
 List item 5 
 List item 6 
 List item 7 
 List item 8 
 List item 9 
 List item 10 
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Here is an example of 'Numbered List 2 (TMCC style)'—this style has 12pt spacing above and below each numbered item. 

1. List item 1 

2. List item 2 

3. List item 3 

Styles Q & A 
When is the 'Spacing' style format used? 

Use the 'Spacing' style when you need a little extra space (such as after a table or after the last bullet in a list); 
this is a single-spaced style not intended to be used to format text, but meant to put more space between the end 
of a line and the beginning of the next line. 

When is the 'Heading 2' (H2) style format used? 

H2 should only be used as the main header style just underneath the main header on the first page. It is 
intended primarily for "overflow" text that will not fit in the main header, e.g., if your document is an 
agenda/minutes your main title might be : "Meeting Minutes" and your H2 sub-head would be the date: "Oct. 11, 
2015". Or, if the full title for your document was: "Instructional Qualifications Policy for Faculty" you would list 
"Instructional Qualifications Policy" as your main header and "for Faculty" as your H2 sub-head. 

How do I add an address line to the top of my document? 

Some departments may choose to have their contact information included in the header of their documents and 
forms. The template would then include this information above the main title, on the right side. Contact Web 
Services to have us work with you on how to properly format this. 

How do I add a sub-header that has the document title on the second and ongoing pages of my document? 

Double click into the header area of your document on page two; enter your sub-head text and format it as 
Heading 4 (TMCC Style). Then, in the Paragraph area of the ribbon, choose the "right align" option. 

 

http://www.tmcc.edu/web/contact/
http://www.tmcc.edu/web/contact/
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What is the difference between a "hard" return and a "soft" return? 

• Hard return: Pressing the Enter key in Word ends a paragraph. It’s officially known as typing a hard return. Yes, 
it’s a return even though the key is known as Enter on a PC. The hard return adds a given amount of space after a 
paragraph. 

• Soft return: When you need to put lines of text close together, you can choose to use a soft return. The soft 
return, or line break, is used primarily in titles and headings; when you have a long title and need to split it up 
between two lines. Press Shift+Enter to insert a soft return. The soft return keeps the title text together (in the 
same paragraph), but on separate lines. You could also use a soft return when typing an address. If you try typing 
the lines of an address and pressing Enter after each line, you see more space between the lines, which isn’t what 
you want. Be careful not to overuse soft returns, however; try using the TMCC "spacing" style, outlined above. 

What are some things I should avoid when using the TMCC styles and template? 

• Overwriting the built-in TMCC styles by adjusting font sizing, line or paragraph spacing, etc. 

• Using semi-colons after headers/sub-headers. 

• Using specific dates in your document (especially in the title/header) -- doing so ensures that the document has a 
very short life on the web; try to make your documents generic whenever possible. 

• Applying unnecessary graphic formatting into your document (e.g., boxes with inset lines, shadows, etc.). 

• Using Bold, italics, **asterisks**, ALL CAPS, underlining, etc. for emphasis. Especially note that underlining text in 
documents intended to be posted online can be confused with web links and are therefore not best practice. TMCC 
style does not use underlining at all. 

• Most of the time, when underlining or boldface type is used in documents, it can and should be replaced with 
italics. Italics can be used for emphasis, the title of books, introducing a new term, and words that could easily be 
misread. 

• Don't be too "wordy" -- keep your documents short and sweet! 

Checklist of Guidelines and Best Practices 
• Are you using the most recent TMCC template, found online at templates.tmcc.edu? 

• Did you follow the instructions for headers/footers and metadata? 

• Did you list your department as the "author" in the metadata? 

• Is your header/title too long (does it wrap)? If so, be sure to use the H2 sub-header and put "overflow" information 
there. 

• Did you use the TMCC pre-set styles (including hyperlinks, etc.) 

• Did you follow AP style: http://www.tmcc.edu/web/writing-for-the-web/style-and-appearance/. 

• Did you name the document appropriately for the web? You can check your department's documents and forms for 
examples. 

• Were you consistent both within your document and among other documents created by your department? 

• Use department names instead of staff member names (i.e., make your contact information generic enough so 
that the form/document can be used even if a key staff member relocates or leaves). 

http://www.louis-hoffman-virtualclassroom.com/Psychology%20Resources/Writing%20Resources/APA_style_little_things.htm#Emphasis
http://templates.tmcc.edu/
http://www.tmcc.edu/web/writing-for-the-web/style-and-appearance/
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